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DM-TXRX-100-STR: HD Streaming 
Transmitter/Receiver 

Introduction 
The Crestron® DM-TXRX-100-STR is an H.264 streaming encoder/decoder designed  
to enable the distribution of high-definition audio/video signals over an IP network.  
The DM-TXRX-100-STR is configurable as either a transmitter or receiver. As a streaming 
transmitter, the DM-TXRX-100-STR allows a laptop computer, camera, or other media 
source to be connected via an HDMI® cable and streamed out over an Ethernet LAN, WAN, 
or Internet connection. The H.264 encoded signal can be routed to the streaming input of a 
DigitalMedia™ switcher, a DM-RMC-100-STR, or another DM-TXRX-100-STR, or it can be 
viewed on Crestron touch screens, digital signage displays, mobile devices, and other 
H.264 compatible equipment. As a streaming receiver, the DM-TXRX-100-STR decodes the 
streaming signal from a DigitalMedia switcher, IP camera, or other streaming source and 
then outputs the signal as an HDMI signal to feed the input of a display device, AV receiver, 
or switcher.  

The web-based user interface of the DM-TXRX-100-STR facilitates configuration of the 
DM-TXRX-100-STR from a laptop. Extensive configuration, control, and monitoring of the 
DM-TXRX-100-STR are also provided through integration with a Crestron control system. 

This guide provides information about configuration of the DM-TXRX-100-STR using the 
web-based user interface. For additional information, refer to the DM-TXRX-100-STR DO 
Guide (Doc. 7620). 

User Interface Overview 
The user interface of the DM-TXRX-100-STR consists of built-in web pages that allow 
configuration of stream, on-screen display, HDMI input, HDMI output, network, and device 
settings. In addition, status information about the DM-TXRX-100-STR can be viewed. 

Accessing the User Interface 
The user interface is accessed from a web browser. The following table lists various 
operating systems and the corresponding web browsers that are supported by the  
DM-TXRX-100-STR user interface. 
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Operating System and Supported Web Browsers for the DM-TXRX-100-STR User Interface 

OPERATING SYSTEM SUPPORTED WEB BROWSERS 

Windows® operating system Internet Explorer® web browser, version 9 and later 
Chrome™ web browser, version 31 and later 
Firefox®  web browser, version 31 and later 

OS X® operating system 
 
 

Safari® web browser, version 6 and later 
Chrome web browser, version 31 and later 
Firefox web browser, version 31 and later 

iOS® operating system Safari web browser, version 6 and later 
Chrome web browser, version 31 and later 

Android™ operating system Chrome web browser, version 31 and later 

 
To access the user interface, do either of the following: 

• Open a web browser directly. For additional information, refer to “Opening a Web 
Browser Directly” on the following page. 

• Open a web browser within the Crestron Toolbox™ application. For additional 
information, refer to “Opening a Web Browser within the Crestron Toolbox 
Application” on the following page. 

Opening a Web Browser Directly 
To access the user interface by opening a web browser directly, do the following: 

1. Find the IP address of the DM-TXRX-100-STR by pressing the SETUP button on 
the device and noting the IP address on the connected display. The IP address is 
displayed for 10 seconds. 

2. Open a web browser. 

3. Go to the IP address of the DM-TXRX-100-STR. 

NOTE:  A warning indicating a security certificate problem or privacy error may 
appear. Ignore the warning and continue to access the DM-TXRX-100-STR web 
interface. 

The user name and password dialog box opens. For login information, refer to 
“Logging In to the DM-TXRX-100-STR” on the following page. 

Opening a Web Browser within the Crestron Toolbox Application 
To access the user interface by opening a web browser within the Crestron Toolbox 
application, do the following: 

1. Open the Crestron Toolbox application. 

2. From the Tools menu, select Device Discovery Tool. 

NOTE:  You can also access the Device Discovery Tool by clicking the Device 
Discovery Tool button ( ) in the toolbar. 
 
NOTE:  The security software running on the computer may send a program alert 
regarding the attempt of the Crestron Toolbox application to connect to the 
network. Allow the connection so that the Device Discovery Tool can be used. 
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The DM-TXRX-100-STR is automatically discovered and is listed in the device list 
on the left-hand side of the screen. The associated host name, IP address, and 
firmware version are also displayed. 

3. In the device list, double-click DM-TXRX-100-STR. 

The Authentication dialog box opens. 

4. Do the following: 

a. Enter a user name and password. The default user name is admin, and the 
default password is admin. 

b. Click the OK button. 

A configuration pane appears for the DM-TXRX-100-STR. 

5. Click the Web Configuration button. 

A browser window opens. 

NOTE:  A warning indicating a security certificate problem or privacy error may 
appear. Ignore the warning and continue to access the DM-TXRX-100-STR web 
interface. 

The user name and password dialog box opens. For login information, refer to 
“Logging In to the DM-TXRX-100-STR” on the following page. 

Logging In to the DM-TXRX-100-STR 
The user name and password dialog box allows login to the DM-TXRX-100-STR. 

NOTE:  Depending on the web browser being used, the user name and password dialog 
box may vary from the dialog box shown below. 

User Name and Password Dialog Box 

 

To log in to the DM-TXRX-100-STR, do the following: 

1. Enter the user name and password. The default user name is admin, and the 
default password is admin. 

NOTE:  The user name and password are case sensitive. 

NOTE:  For enhanced security, it is recommended that the password be changed. 
For information about changing the password, refer to “Changing the Password” on 
page 23. 
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2. Click Log In. 

The Status page opens. For information about navigating the user interface, refer to 
“Navigating the User Interface” below. For information about the Status page and all 
configuration pages of the DM-TXRX-100-STR, refer to “Status and Configuration” 
on page 5. 

Navigating the User Interface 
The user interface provides a navigation bar and the built-in web pages of the  
DM-TXRX-100-STR.  

DM-TXRX-100-STR User Interface (Sample Status Page Shown) 

 

The navigation bar provides access to the web pages as follows: 

• Clicking STATUS accesses the Status page, which provides general information 
about the DM-TXRX-100-STR as well as network-related and control system 
information. For additional information, refer to “Viewing DM-TXRX-100-STR Status 
Information” on page 5.  

• Clicking STREAM accesses the Stream page, which allows configuration of the 
DM-TXRX-100-STR as a streaming transmitter or receiver. For additional 
information, refer to “Configuring Stream Settings” on page 7. 
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• Clicking ON-SCREEN DISPLAY accesses the On-Screen Display page, which 
allows text to be overlaid on the connected display. For additional information, refer 
to “Configuring On-Screen Display Settings” on page 13. 

• Clicking HDMI INPUT accesses the HDMI Input page, which allows the desired 
EDID file to be selected and sent to the HDMI input. For additional information, refer 
to “Configuring HDMI Input Settings” on page 14. 

• Clicking HDMI OUTPUT accesses the HDMI Output page, which allows the HDMI 
output to be enabled or disabled and the output resolution to be set. For additional 
information, refer to “Configuring HDMI Output Settings” on page 16. 

• Clicking NETWORK accesses the Network page, which allows network settings 
such as host name, domain name, and DHCP (Dynamic Host Configuration 
Protocol) mode to be set. For additional information, refer to” Configuring Network 
Settings” on page 18. 

• Clicking DEVICE accesses the Device page, which sets up connection to a control 
system and controls various device functions. For additional information, refer to 
“Configuring Device Settings” on page 19. 

Status and Configuration 
The web-based user interface of the DM-TXRX-100-STR displays status information and 
allows configuration of the following: 

• Stream settings 

• On-screen display settings 

• HDMI input settings 

• HDMI output settings 

• Network settings 

• Device settings 

Viewing DM-TXRX-100-STR Status Information 
General information, such as model name, serial number, and firmware version of the 
DM-TXRX-100-STR, can be viewed. The current network settings, such as host name and 
IP address, can also be viewed. Control system connection information is also provided. 

To view status information, do the following:  In the navigation bar, click STATUS.  
The Status page opens. 

NOTE:  The Status page opens after logging in to the DM-TXRX-100-STR.  
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Sample Status Page 

 

The Status page displays the following information about the DM-TXRX-100-STR: 

• General information, which consists of the following: 

o Model, which is DM-TXRX-100-STR 

o Serial Number 

o Main Firmware Version 

o Updater 

o Bootloader 

• Network-related information, which consists of the following: 

o Host Name 

NOTE:  In the sample Status page shown above, the default host name is 
DM-TXRX-100-STR-00107F5D13B7, where 00:10:7f:5d:13:b7 is the MAC 
address of the device. 

o IP Address 

o Subnet Mask 
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o Default Gateway 

o MAC Address 

• Control system connection information, which consists of the following: 

o Address  

o IP ID 

o Port 

o Status (OFFLINE or ONLINE) 

Configuring Stream Settings 
To configure stream settings, do the following: 

1. In the navigation bar, click STREAM. The Stream page opens.  

Stream Page 

 

2. Configure stream settings. Refer to the following table for stream configuration 
guidelines. In addition, refer to the Streaming Design Guide (Doc. 7610) at 
www.crestron.com/manuals for information about DigitalMedia streaming. 

  

http://www.crestron.com/manuals
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Stream Configuration Guidelines 

CONFIGURATION 
ITEM 

 
GUIDELINES 

Mode Specifies the mode of operation of the DM-TXRX-100-STR. In the Mode 
drop-down list, select either of the following: 

• Receiver:  Allows the DM-TXRX-100-STR to function as a 
streaming receiver 

• Transmitter:  (Default setting) Allows the DM-TXRX-100-STR to 
function as a streaming transmitter 

Initiation  
 
 

Specifies the streaming method used to determine when the 
DM-TXRX-100-STR is to begin streaming. In the Initiation drop-down 
list, select one of the following: 

• By Receiver:  (Default setting) Specifies a unicast RTSP H.264 
stream or HTTP MJPEG stream: 
o If Mode is set to Receiver, the DM-TXRX-100-STR 

attempts to connect to the transmitting device whose 
address is specified in the Stream Location text box.  
The stream must be configured before the 
DM-TXRX-100-STR can connect to the transmitting device. 
Refer to the documentation of the transmitting device for 
information about configuring the device.  

o If Mode is set to Transmitter, the DM-TXRX-100-STR waits 
for an incoming connection from a client. When the client 
connects, the initiation session parameters are exchanged 
and the stream begins.  

• By Transmitter:  Specifies a unicast UDP stream: 
o If Mode is set to Receiver, the DM-TXRX-100-STR waits for 

an incoming connection from a client. When the client 
connects, the initiation session parameters are exchanged 
and the stream begins. 

o If Mode is set to Transmitter, the DM-TXRX-100-STR 
attempts to connect to the receiving device whose address 
is specified in the Stream Location text box. The stream 
must be configured before the DM-TXRX-100-STR can 
connect to the receiving device. Refer to the documentation 
of the receiving device for information about configuring the 
device. 

• Multicast via RTSP:  Specifies a multicast RTSP stream: 
o If Mode is set to Receiver, the DM-TXRX-100-STR 

attempts to connect to the transmitting device whose 
address is specified in the Stream Location text box.  
The stream must be configured before the 
DM-TXRX-100-STR can connect to the transmitting device. 
Refer to the documentation of the transmitting device for 
information about configuring the device.  

o If Mode is set to Transmitter, the DM-TXRX-100-STR waits 
for an incoming connection from a client.  
The stream is sent to the multicast IP address specified in 
the RTSP Multicast Address text box.  

(Continued on following page)  
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Stream Configuration Guidelines (Continued) 

CONFIGURATION 
ITEM 

 
GUIDELINES 

Initiation 
(Continued) 

• Multicast via UDP:  Specifies a multicast UDP stream: 
o If Mode is set to Receiver, the DM-TXRX-100-STR 

attempts to connect to the transmitting device whose 
multicast IP address is specified in the Multicast Stream 
Location text box.  

o If Mode is set to Transmitter, the DM-TXRX-100-STR 
begins streaming to the multicast IP address specified in the 
Multicast Stream Location text box. 

Stream 
Location 

(Enabled only when Initiation is set to By Receiver, By Transmitter, or 
Multicast via RTSP) If Mode is set to Receiver, enter the stream 
location using the standard scheme format:  

• If Initiation is set to By Receiver:  
o For a unicast RTSP stream, enter the RTSP URL, for 

example: 
rtsp://streaming.server.com:544/path/to/file.sdp  

o For an MJPEG stream, enter the HTTP URL, for example: 
http://192.168.2.100/video.mjpg   

• If Initiation is set to Multicast via RTSP, enter the RTSP URL, for 
example: rtsp://streaming.server.com:544/path/to/file.sdp  

If Mode is set to Transmitter and Initiation is set to By Receiver or 
Multicast via RTSP, the Stream Location text box is read only and 
displays the RTSP URL of the client. 
If Mode is set to Transmitter and Initiation is set to By Transmitter, 
enter the IP address of the receiving device, for example: 
192.168.2.100 

Multicast 
Stream 
Location 

(Enabled only when Initiation is set to Multicast via UDP) Enter the 
multicast IP address in dotted decimal notation, for example:  225.1.1.1 

RTSP Multicast 
Address 

(Enabled only when Mode is set to Transmitter and Initiation is set to 
Multicast via RTSP)  Enter the multicast IP address in dotted decimal 
notation,  for example:  225.1.1.1 

Transport Mode Specifies the stream type. In the Transport Mode drop-down list, select 
one of the following:  

• RTP:  Allows the DM-TXRX-100-STR to stream the audio and 
video as separate RTP streams. Each RTP stream uses a different 
port. Refer to the documentation of the receiving or transmitting 
device to verify that this setting should be used. 

• MPEG2TSRTP:  (Default setting) Allows the DM-TXRX-100-STR 
to receive or transmit MPEG-2 TS streams with RTP 
encapsulation. Only one port number is consumed by the 
encapsulation. The default port number is 4570.  

• NOTE:  MPEG2TSRTP supports the streaming of HDCP content 
to a Crestron HDCP streaming receiver. Refer to the 
documentation of the receiving or transmitting device to verify that 
the device can encapsulate the stream in MPEG-2 TS. 

(Continued on following page) 
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Stream Configuration Guidelines (Continued) 

CONFIGURATION 
ITEM 

 
GUIDELINES 

Transport Mode 
(Continued) 

• MPEG2TSUDP:  Allows the DM-TXRX-100-STR to receive or 
transmit MPEG-2 TS UDP streams. Only one port number is 
consumed by the encapsulation. The default port number is 
4570. 

NOTE:  MPEG2TSUDP is recommended for multicast UDP streams. 
MPEG2TSUDP supports the streaming of HDCP content to a Crestron 
HDCP streaming receiver. Refer to the documentation of the receiving 
or transmitting device to verify that the device can encapsulate the 
stream in MPEG-2 TS. 

Custom Ports Enables or disables the assignment of custom port numbers for the 
selected Initiation method (By Receiver, By Transmitter, Multicast via 
RTSP, or Multicast via UDP). By default, the Custom Ports check box 
is deselected. The default port numbers are as follows:  

• For By Receiver, the default RTSP port number is 554.  
• For By Transmitter, the default port numbers are as follows:  

o If Transport Mode is set to RTP, the default RTP video port 
number is 49170 and the default audio port number is 
49172. The audio port number is always the next  
even-numbered port number following the video port 
number.  

o If Transport Mode is set to MPEG2TSRTP or 
MPEG2TSUDP, the default TS port number is 4570.  

• For Multicast via RTSP, the default RTSP port number is 554.  
• For Multicast via UDP, the default port numbers are as follows:  

o If Transport Mode is set to RTP, the default RTP video port 
number is 49170 and the default audio port number is 
49172. The audio port number is always the next  
even-numbered port number following the video port 
number.  

o If Transport Mode is set to MPEG2TSRTP or 
MPEG2TSUDP, the default TS port number is 4570.  

To change the port numbers, select the Custom Ports check box and 
do the following:  

• For By Receiver, enter the desired port number in the RTSP Port 
text box. Valid values range from 1 to 65535.  

• For By Transmitter, enter the desired port number in the RTP 
Video Port or TS Port text box. Valid values range from 1 to 
65535. The audio port number becomes the next  
even-numbered port number following the video port number.  

• For Multicast via RTSP, enter the desired port number in the 
RTSP Port text box. Valid values range from 1 to 65535.  

• For Multicast via UDP, enter the desired port number in the RTP 
Video Port or TS Port text box. Valid values range from 1 to 
65535. The audio port number becomes the next  
even-numbered port number following the video port number.  

(Continued on following page) 
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Stream Configuration Guidelines (Continued) 

CONFIGURATION 
ITEM 

 
GUIDELINES 

HDCP Support (Applicable only when Mode is set to Transmitter, Initiation is set to  
By Receiver, and Transport Mode is set to MPEG2TSRTP or 
MPEG2TSUDP) Specifies when HDCP content can be streamed to a 
Crestron HDCP streaming receiver: 

• Follows input:  (Default setting) The streaming content is 
encrypted only when HDCP content is detected at the HDMI 
input. 

• Always:  The streaming content is encrypted regardless of 
whether HDCP content is detected at the HDMI input. 

• Never:  The streaming content is not encrypted regardless of 
whether HDCP content is detected at the HDMI input. 

Stream Options, 
Buffer 

(Applicable only when Mode is set to Receiver) Specifies the amount of 
time in milliseconds that the device delays before playout of the audio 
and video in the stream buffer. Larger buffers absorb disturbances in 
the stream but result in more latency. In the Buffer drop-down list, 
select one of the following:  
 Minimal (<100ms latency) 
 Small (100-500ms latency) 
 Medium (1000ms latency) 
 Large (5000ms latency) 
 Custom 
The default setting is Medium (1000ms latency). 
If Custom is selected, the Custom Buffer (ms) spin box is enabled. 
Click the up or down arrow to select the desired custom buffer size. 
Available values range from 0 to 5000 milliseconds. 

Stream Options, 
Statistics 

(Applicable only when Mode is set to Receiver) Enables or disables 
statistics for the number of dropped packets for video and audio.  
By default, the Disable radio button is selected. To enable statistics, 
click the Enable radio button. The Dropped Packets fields (read only) 
display the statistics for video and audio.  
To reset the statistics, click the Reset Statistics button.  
If the Disable radio button is selected, the Dropped Packets fields and 
the Reset Statistics button are disabled. 

Stream Options, 
Encoding FPS 

(Applicable only when Mode is set to Transmitter) Specifies the number 
of frames per second (FPS) for encoding. In the Encoding FPS  
drop-down list, select one of the following values:  25, 30, 50, or 60. 
The default setting is 60. 

Stream Options, 
Format 

(Applicable only when Mode is set to Transmitter)  Specifies the 
resolution of the stream. In the Format drop-down list, select one of the 
following: 
 Auto (Recommended) 720x480 1366x768 
 176x144 800x480 1440x900 
 352x288 800x600 1600x900 
 528x384 1024x768 1600x1200 
 640x360 1280x720 1680x1050 
 640x480 1280x800 1920x1080 
The default setting is Auto (Recommended). Auto follows the input 
resolution. 

(Continued on following page) 
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Stream Configuration Guidelines (Continued) 

CONFIGURATION 
ITEM 

 
GUIDELINES 

Stream Options, 
Profile 

(Applicable only when Mode is set to Transmitter) Specifies the set of 
capabilities that target specific classes of applications. In the Profile 
drop-down list, select one of the following: 

• High:  (Default setting) Specifies the primary profile for broadcast 
and disc storage applications, particularly for high-definition 
television applications   

• Main:  Specifies the profile used for standard-definition digital 
television broadcasts that use the MPEG-4 format defined in the 
Digital Video Broadcasting (DVB) standard 

• Baseline:  Specifies a profile used primarily for videoconferencing 
and mobile applications 

Stream Options, 
Bitrate 

(Applicable only when Mode is set to Transmitter) Specifies the bit rate 
of the stream in kilobits per second (kbps). In the Bitrate drop-down list, 
select one of the following values: 
 500 5000 
 1000 6000 
 1500 7000 
 2000 8000 
 2500 9000 
 3000 10000 
 3500 20000 
 4000 25000 
 4500 Custom 
The default setting is 10000 kbps. 
If Custom is selected, the Custom Bitrate text box is enabled. Enter 
the desired bit rate. Valid values range from 96 to 25000 kbps. 

Output Options, 
Resolution 

Specifies the resolution of the HDMI output. In the Resolution  
drop-down list, select one of the following: 
NOTE:  In the following list, RB denotes Reduced Blanking. 
 Auto (follows input) 1440x900@60 
 640x480@60 1440x900@60 RB  
 800x600@60 1600x900@60 RB  
 1024x768@60 1600x1200@60  
 1280x720@50 1680x1050@60  
 1280x720@60 1680x1050@60 RB  
 1280x800@60 1920x1080@50  
 1280x800@60 RB 1920x1080@60  
 1366x768@60 1920x1200@60 RB 
 1366x768@60 RB 
The default setting is Auto (follows input). 

Volume The Volume button toggles audio on and off. By default, the Volume 
button is enabled, showing three sound waves emanating from the 
speaker icon ( ). Audio is not muted. 
To adjust the volume, drag the Volume slider to the left or to the right. 
The volume decreases when the slider is dragged to the left and 
increases when the slider is dragged to the right. Values range from 
-80 to 0 decibels. The default setting is 0. 
To mute the audio, disable the Volume button by clicking the button. 
The red slash across the speaker icon ( ) indicates that audio is muted.   
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3. Use the transport buttons to control streaming as appropriate: 

• Begin streaming by selecting the Start button ( ). The button starts 
blinking green every 500 milliseconds while the DM-TXRX-100-STR sets up 
the stream. When the stream starts, the button becomes solid green.  
The Status field (read only) indicates that the stream started. 

• Pause streaming by selecting the Pause button ( ). The button starts 
blinking yellow every 500 milliseconds until the stream pauses. When the 
stream pauses, the button becomes solid yellow. The Status field (read 
only) indicates that the stream paused.  

• Stop streaming by selecting the Stop button ( ). The button starts 
blinking red every 500 milliseconds until the stream stops. When the 
stream stops, the button becomes solid red. The Status field (read only) 
indicates that the stream stopped. 

Configuring On-Screen Display Settings 
On-screen display settings can be configured to allow text to be overlaid on the connected 
display. Text can be overlaid for purposes such as labeling the video or displaying 
instructions, schedules, or alerts.  

To configure text overlay settings, do the following:  

1. In the navigation bar, click ON-SCREEN DISPLAY. The On-Screen Display page 
opens.  

On-Screen Display Page 

 

2. Enable text overlay by clicking the Enable radio button if it is not already selected. 
By default, the Disable radio button is selected, preventing text from being overlaid 
on the connected display.  

3. In the Text to display text box, enter the desired text. 

4. In the Location drop-down list, select one of the following options to position the 
text on the display device:  Custom, Upper Left (default setting), Center Left, 
Lower Left, Upper Right, Center Right, or Lower Right. 

If Custom is selected, enter the X (horizontal) and Y (vertical) coordinates in pixels 
to position the text on the display. 
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Configuring HDMI Input Settings 
HDMI input settings can be configured to enable or disable HDCP (High-bandwidth Digital 
Content Protection) and to select the desired EDID file. Five built-in EDID files are available 
for selection, and custom EDID files can also be selected. In addition, information about the 
HDMI input signal can be viewed. 

To configure HDMI input settings, do the following: 

1. In the navigation bar, click HDMI INPUT. The HDMI Input page opens.  

HDMI Input Page—Input Settings  

 

2. In the HDCP Support drop-down list, select Disabled or Enabled. The default 
setting is Enabled. 

NOTE:  In order for HDCP streaming to occur, the Transport Mode configuration 
item on the Stream page must be set to MPEG2TSRTP or MPEG2TSUDP (refer to 
pages 9 and 10 for information about Transport Mode settings. 

3. In the EDID section of the page, do the following: 

a. In the Select drop-down list, select the desired EDID file or select Custom. 
By default, the available selections, which include the five built-in EDID files, 
are as follows:  

DM default EDID (Default setting) 
Laptop 16x10 1280x800 2CH 
Laptop 16x9 1080P 2CH 
Laptop 16x9 1080P50 2CH 
Laptop widescreen 2CH 
Custom… 

If an EDID file in the Select drop-down list is selected, continue with  
step 3b. If Custom is selected, omit step 3b and continue with step 3c.  

b. (Applicable only when an EDID file is selected) Do the following: 

i. Click the Apply EDID button. The Apply EDID message box 
appears, asking for confirmation that the EDID be applied. 

ii. Click Yes to apply the EDID. When the EDID is applied 
successfully, the Apply EDID message box appears indicating 
success.  

iii. Close the Apply EDID message box by clicking the X in the upper 
right-hand corner of the box. 
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c. (Applicable only when Custom is selected) Do the following: 

i. Click the Browse button located to the right of the Load CEDID 
file field. Windows Explorer opens. 

ii. Locate and select the desired EDID file (*.cedid), and then click the 
Open button. 

NOTE:  Only 2-channel LPCM audio is supported. Multichannel 
audio is not supported and, therefore, will be muted. 

 The selected EDID file appears in the Load CEDID file field. 

iii. Click the Send EDID button to send the EDID to the input device. 
The SEND EDID message box appears, asking for confirmation 
that the EDID be sent to the input device. 

iv. Click the Start button to send the EDID file to the input device. 
The Send EDID message box appears indicating success. 

v. Close the Send EDID message box by clicking the X in the upper 
right-hand corner of the box. 

The custom EDID file is added to the Select drop-down list. 

To delete a custom EDID file from the Select drop-down list, do the following: 

NOTE:  Only custom EDID files can be deleted. Built-in EDID files cannot be deleted. 

1. In the Select drop-down list, select the custom EDID file to be deleted. 

2. Click the Delete button. The Delete EDID message box appears, asking for 
confirmation that the EDID be removed. 

3. Click Yes to delete the EDID. The Delete EDID message box appears indicating 
success. 

4. Close the message box by clicking the X in the upper right-hand corner of the box. 

The custom EDID file is deleted from the Select drop-down list. 

The HDMI Input page also displays information about the HDMI input signal in the Input 
Signal section of the page. 

HDMI Input Page—Input Signal Information 

  

 

 

 



 

16  •  DM-TXRX-100-STR: HD Streaming Transmitter/Receiver Supplemental Guide – DOC. 7845B 

The following information is displayed in the Input Signal section of the HDMI Input page: 

• Sync Detected:  Specifies whether a source is detected at the HDMI input: 

o A green icon indicates that a source is detected. 

o A gray icon indicates that a source is not detected.  

• Resolution:  Specifies the current resolution of the input signal 

• HDCP:  Specifies whether HDCP is active or inactive 

To view additional details about the input signal, click the More details >> button. To view 
fewer details about the input signal, click the Fewer details<< button. 

Configuring HDMI Output Settings 
The HDMI output can be enabled or disabled. In addition, the output resolution and the 
enabling of HDCP can be configured. Information about the HDMI output signal can also  
be viewed. 

To configure HDMI output settings, do the following:  

1. In the navigation bar, click HDMI OUTPUT. The HDMI Output page opens. 

HDMI Output Page—Output Settings 

 

2. Enable or disable the HDMI output by selecting the Enable or Disable radio button, 
respectively. By default, the Enable radio button is selected, allowing the output 
display to turn on. If the Disable radio button is selected, the output display  
turns off. 

3. In the Resolution drop-down list, select the desired resolution of the HDMI output. 
The following settings are available: 

NOTE:  In the following list, RB denotes Reduced Blanking. 

Auto (Recommended) 1440x900@60 
640x480@60 1440x900@60 RB  
800x600@60 1600x900@60 RB  
1024x768@60 1600x1200@60 
1280x720@50 1680x1050@60 
1280x720@60 1680x1050@60 RB 
1280x800@60 1920x1080@50 
1280x800@60 RB 1920x1080@60 
1366x768@60 1920x1200@60 RB 
1366x768@60 RB   

The default setting is Auto (Recommended). 
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4. In the HDCP Enabled drop-down list, select one of the following: 

• Automatic:  (Default setting) Allows HDCP to be enabled for the output 
only when the input requires HDCP.  If the input does not require HDCP, 
HDCP is disabled for the output. 

• Always Enabled:  Allows HDCP to always be enabled for the output 
regardless of the input requirements. 

The HDMI Output page displays information about the HDMI output signal in the Output 
Signal section of the page.    

HDMI Output Page—Output Signal Information 

 

As shown above, the following information is displayed: 

• Sync Detected:  Specifies whether the HDMI output signal is detected by the 
connected display: 

o  A green icon indicates that the HDMI output signal is detected. 

o A gray icon indicates that the HDMI output signal is not detected. 

• Resolution:  Specifies the current resolution of the HDMI output signal 

• HDCP:  Specifies whether HDCP is active or inactive 

To view additional details about the output signal, click the More details>> button. To view 
fewer details about the output signal, click the Fewer details<< button. 
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Configuring Network Settings 
To configure network settings, do the following: 

1. In the navigation bar, click NETWORK. The Network page opens.  

Network Page 

 

2. Configure network settings. Refer to the following table for configuration guidelines. 

Network Configuration Guidelines 

CONFIGURATION 
ITEM 

 
GUIDELINES 

Host Name Specifies the host name that identifies the DM-TXRX-100-STR on the 
network. The default host name is DM-TXRX-100-STR-xxxxxxxxxxxx, 
where xxxxxxxxxxxx is the MAC address of the DM-TXRX-100-STR. 
Overwrite the existing host name in the Host Name text box with the 
desired new host name. The host name is restricted to the letters  
a to z (not case sensitive), the digits 1 to 9, and the hyphen. 

Domain Name Specifies a domain name. 

DHCP Specifies whether the IP address of the DM-TXRX-100-STR is to be 
assigned by a DHCP (Dynamic Host Configuration Protocol) server.  
To set the IP address, click either of the following radio buttons: 

• Obtain an IP address automatically:  (Default setting) Allows 
the IP address of the DM-TXRX-100-STR to be automatically 
assigned by a DHCP server on the local area network (LAN) for a 
predetermined period of time. 

 • Use the following IP address:  Allows a static IP address and 
associated network settings to be configured for the 
DM-TXRX-100-STR: 
o IP address:  Enter a unique IP address for the 

DM-TXRX-100-STR. 

(Continued on following page) 
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Network Configuration Guidelines 

CONFIGURATION 
ITEM 

 
GUIDELINES 

DHCP 
(Continued) 

o Subnet Mask:  Enter the subnet mask that is set on the 
network. 

o Default Gateway:  Enter the IP address that is to be used 
as the network’s gateway. 

o DNS Server:  Enter the IP address of the primary  
DNS server. 

3. Do either of the following: 

• To save the current entries, click the Save button. The DM-TXRX-100-STR 
automatically reboots. 

• To revert to the previous settings without saving the current entries, click 
the Revert button. 

Configuring Device Settings 
Configuration and management of device settings consist of the following: 

• Controlling the display of the LEDs 

• Connecting the DM-TXRX-100-STR to a control system  

• Upgrading firmware 

• Restoring factory default settings 

• Rebooting the DM-TXRX-100-STR 

• Downloading device logs 

• Changing the password 

Controlling the Display of the LEDs 
The LEDs on the DM-TXRX-100-STR can be enabled or disabled. 

NOTE:  When the LEDs are disabled, all LEDs—including the power and Ethernet LEDs—
turn off. The DM-TXRX-100-STR appears as though it is not powered on; however, the 
device remains powered on and continues to function. 
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To control the display of the LEDs, do the following: 

1. In the navigation bar, click Device. The Device page, which includes a Display 
section, opens. 

Device Page—Display 

 

2. In the Display section of the page, do either of the following: 

• To enable the display of the LEDs, click the Enabled radio button if it is not 
already selected. By default, the LEDs are enabled. 

• To disable the display of the LEDs, click the Disabled radio button.  
Although the LEDs become disabled, the DM-TXRX-100-STR continues to 
function.  

Connecting the DM-TXRX-100-STR to a Control System 
To connect the DM-TXRX-100-STR to a control system, do the following: 

1. In the navigation bar, click DEVICE. The Device page, which includes a Control 
System section, opens.  

Device Page—Control System 

 

2. In the Control System section of the page, do the following: 

a. In the Encrypt Connection drop-down list, select No or Yes. The default 
setting is No. 

b. In the IP Address/Hostname text box, enter the IP address or host name 
of the control system. 

c. In the IP ID text box, enter the IP ID of the control system. Valid values 
range from 03 to FE in hexadecimal notation.  
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d. Do either of the following: 

• To save the current entries, click the Save button. The Control 
System Save message box appears, indicating that the control 
system settings were saved successfully.  

• To revert to the previous settings without saving the current 
entries, click the Revert button. 

The Status field (read only) displays the connection status of the 
DM-TXRX-100-STR to the control system as Offline or Online.  

Upgrading Firmware 
To upgrade firmware of the DM-TXRX-100-STR, do the following: 

1. In the navigation bar, click DEVICE. The Device page, which includes a Firmware 
section, opens. 

Device Page—Firmware 

 

The Firmware section displays the following information about the  
DM-TXRX-100-STR: 

• Model, which is DM-TXRX-100-STR 

• Serial Number 

• Firmware Version 

2. To upgrade the firmware, click the Upload firmware file radio button or the Use 
service port radio button: 

• If the Upload firmware file radio button is selected, do the following: 

a. Click the Browse button. 

b. Locate and select the desired firmware file (*.zip), and then click 
the Open button. The Upload firmware file field displays the 
firmware filename.  

c. Click the Load button. A message appears, indicating that the 
DM-TXRX-100-STR will reboot.  

d. Click OK to reboot the device. 
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• If the Use service port radio button is selected, do the following: 

a. Insert a USB mass storage device containing the firmware file into 
the SERVICE port of the DM-TXRX-100-STR. 

b. Click the Load button. A message appears, indicating that the 
DM-TXRX-100-STR will reboot. 

c. Click OK to reboot the device. 

Restoring Factory Default Settings 
To restore factory default settings, do the following: 

1. In the navigation bar, click Device. The Device page, which includes a Device 
Management section, opens. 

Device Page—Device Management, Restore 

 

2. Click the Restore button. The Restore message box appears, asking for 
confirmation that the device be restored to factory default settings.   

NOTE:  When settings are restored, all settings—including the network settings—
revert to the factory default settings. If a static IP address is set, restoring the device 
to factory default settings reverts the IP address to DHCP mode, which is the 
factory default IP address setting (refer to “Configuring Network Settings” on  
page 18).    

3. Click Yes to restore factory default settings. The Restore message box appears, 
indicating that the Restore process was successful and that the device rebooted. 

4. Close the message box by clicking the X in the upper right-hand corner of the box. 

Rebooting the DM-TXRX-100-STR 
To reboot the DM-TXRX-100-STR, do the following: 

1. In the navigation bar, click Device. The Device page, which includes a Device 
Management section, opens.  

Device Page—Device Management, Reboot 

 

2. Click the Reboot button. The Reboot message box appears, asking for 
confirmation that the device be rebooted.  

3. Click Yes to reboot the device. The Reboot message box appears, indicating that 
the device is rebooting. 
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Downloading Device Logs 
To download device logs for troubleshooting purposes, do the following: 

1. In the navigation bar, click Device. The Device page, which includes a Device Logs 
section, opens.  

Device Page—Device Logs 

 

2. Click the Download Logs button. A logs file (*.tgz) is downloaded to the PC or 
mobile device.  

Changing the Password 
To change the password, do the following: 

1. In the navigation bar, click Device. The Device page, which includes a Password 
section, opens.  

Device Page—Password 

 

2. In the Password section of the page, do the following: 

NOTE:  The password is case sensitive. 

a. In the Password text box, enter the desired password. 

b. In the Confirm Password text box, reenter the desired password to 
confirm the password. 

c. Do either of the following:  

• To save the password, click the Save button. A message appears, 
indicating that the password was saved successfully. 

• To revert to the previous setting without saving the current entry, 
click the Revert button. 
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